
Self Reported Business Tax
Release 6.0 version 1.0

Last Revision Update:  8/6/15



Govern

Business Tax

Govern for .NETTM

Version: 1.0

July 2015 - Release 6.0

Copyright © Harris Govern

1997 - 2015

All rights reserved



Disclaimer

Harris Govern has taken due care in preparing this manual. However, nothing 
contained herein modifies or alters in any way the standard terms and 
conditions of the purchase, lease, or license agreement by which the product 
was acquired, nor increases in any way the liability of Harris Govern to the 
customer. 
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Business Tax
Preface
Welcome to Govern, a comprehensive and fully integrated transaction-driven 
system written exclusively for local governments. Govern includes a wide 
variety of database modules:

Computer-Assisted Mass Appraisal (CAMA)
• Appeals & Grievances
• Appraisals / Property Valuations 
• Comparables Sales Management

Financial Management
• Account Receivable
• Cash Collection 

Land Management
• Business & Individual Licenses
• Complaint Tracking
• Leasing
• Permit Tracking & Inspection Scheduling
• Planing
• Violations

Revenue Management
• Aircraft & Boat Excise Tax
• Miscellaneous Billing
• Personal Property Tax Billing
• Real Property Tax Billing
• Self Reported Tax Billing
• Special Assessments
• Tax Title / Tax Lien / Tax Sales
• Utility Billing

Since 1980, MS Govern has worked hand in hand with State and Local 
Governments to simplify the implementation of software solutions that 
automate the flow of information related to their properties.
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Getting Started
Introduction: Business Tax

The Self Reported Tax subsystem has been designed for local governments 
and organizations that need to report the sales tax that are generated from 
local businesses and classified as Self Reported Tax, or Business Tax.

Harris Govern’s Self Reported Tax subsystem provides a flexible 
administrative setup. Administrators are able to set up categories, add 
customized fields with computations rules, define associated tax levies and 
how they can be applied.

Self Reported or Business Tax is collected according to user-defined periods. 
Even for infrequently collected tax, the organization needs to define a Period 
record, with the number of periods set to zero.

Govern Users set up Self Reported Tax accounts for each individual and 
company from whom they need to collect taxes. The Business Data Entry Tax 
function provides detailed information on each record and direct access to the 
Accounts Receivable subsystem for viewing and maintaining records and for 
collecting payments.

Prerequisites

In addition to the Self Reported Tax module, the following Govern™ modules 
are required:

• Property Control
• Accounts Receivable

Overview
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What’s New
What’s New
In this section is a list of new features or changes in functionality in 
the Self Reported Tax module of the Govern for .NET™ release 6.0 
application. Throughout the manual new features are indicated by 

the New symbol

Self Reported Tax Parameters

As a result of the extensive development in Govern release 6.0, Self Reported 
Tax parameters are now setup completely in the Govern New Administration 
(GNA) release 6.0.

When the fields for the forms have been created, the following User Field 
Definition tables, are no longer used:

• USR_FIELDS_DEF
• USR_FIELDS_LABEL
• USR_FIELDS_MASK
• USR_FIELDS_NUMERIC_FORMAT

All the information that was formerly stored in these tables have been 
converted to (Table: ST_PARM_FIELDS). In addition, columns that were 
previously found in (Table: SY_FIELDS_DEF) are now located in (Table: 
ST_PARM_CATEG).

Automatic Filer Creation

All filing records are created for the selected period chosen when the record is 
setup. Empty filers, or "shells", are now created from the starting period up to 
the last period defined in the parameters. This does not necessarily stop at the 
end of the fiscal year. This change will facilitate Self Reported Tax support in 
the eGovernment - Public Web Portal.

Change in Period

Periods can now be changed, e.g. quarterly to monthly. When a period is 
changed, the system will start at the next valid chosen period start date, delete 
the other periods and create the new ones. The Govern system will manage 
the dates so that there are no overlaps. See Self Reported Tax Periods on 
page 44 for details.

NEW
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Getting Started
Self Reported Occasional Filing for Seasonal Businesses

As of Release 6.0 the system supports seasonal filers, e.g. A summer 
business that will only file for 3 monthly period within a year (summer camps, 
private seasonal outdoor pools, and so on). The Occasional Filing has the 
same functionality as the standard Self Reported Tax Filing but simplifies the 
filing process so that seasonal businesses will not have to submit zero filers 
for the months that they do not operate.

As an added feature businesses that initially begin using the occasional filing 
model may at a later date be converted to a standard period based filing 
model without impacting the system. See  Converting from Occasional to 
Standard filing on page 91.

Zero Filer Quick Entry

The Zero Filer Quick Entry feature updates un-filed ST records to the zero filer 
using the current Fiscal Year, Department, and User Login in the application. A 
grid is displayed that is populated with un-posted ST records. Updated filings 
that are added can be quickly entered into the system with a barcode scanner. 
The barcodes are generated by the user.See Zero Filer Quick Entry on 
page 73 for details.

Changes within the Self Reported Tax

Although the Self Reported Tax module has been redesigned for Release 6.0, 
a lot of the changes have occurred in the back end, and are therefore 
transparent to the user. Users that are interested in the changes that have 
occurred to the Govern suite of applications as a whole, should refer to the 
Upgrading from Govern Suite Release 5.1 to 6.0 section of the Govern New 
Administration (GNA) Release 6.0 user guide for details.

Change in management of Account

the management of active and inactive accounts was changed. It has been 
replaced with Last Status Date for Start of inactive or start of active. See A 
note about Amended Files on page 71 for details..

Corrected and Amended Filers

New and improved method for amended and corrected filers. In the case of an 
Amended Filing, user will need to enter the value that is the difference 
between their original filing and the their new filing. In the case of a Corrected 
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What’s New
Filing, the user re-enters the full amount that the data is to be replaced with. 
See Corrected Period on page 70 for details.

eGovernment behavior with Un-filed Accounts

Changes have been made to how the system handles Inactive Accounts that 
are related to SRT. When a user performs a search, the system verifies if any 
resulting accounts have been flagged as un-filed. If any outstanding filings are 
found, the user is redirected to the filing page. Active From: Release 
6.0.1503.410. See eGovern behavior with Un-filed Accounts on page 31

Quick Search

The search feature can be enhanced with a “Quick Save and Search” option 
that improves data entry.When configured this feature reduces the time 
between saving a modification on a record and having to reopen the Search 
form to search for another record. See Self Reported Business Tax Quick 
Search on page 61 for details.
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Self-Reported Tax
 Self Reported Tax OpenForm

This section of the guide describes the functions that comprise the Self 
Reported Tax OpenForm that is accessible to the Govern user:

Self Reported Tax Administration Settings

Use the Self Reported Tax administration forms in the Govern New 
Administration (GNA) to configure the System Registry settings. In Govern this 
feature is used to create an account for each individual and company for 
which you need to collect Self Reported Tax. See Self Reported Tax Account 
Maintenance on page 63.

Search

In order to complete the Self Reported Tax Data Entry form, it is necessary to 
either perform a Search by Name, for the individual or company and account, 
or create a new account, specifying a category and reporting period. See 
Business Tax Search on page 58.

Self Reported Tax Account forms

Self Reported Tax Account

Use the Self Reported Tax Account Maintenance feature to create an account 
for each individual and company for which you need to collect Self Reported 
Tax. See Self Reported Tax Account Maintenance on page 63.

Link to Parcel ID group

Records from other modules can be linked to the Self Reported Tax record 
using the Link to Parcel ID group. Module records that can be linked include, 
Permits/Offenses/Workflow, Buildings, Inspections, Misc. Billing (MB), Utility 
Billing (UB), and Personal Property (PP). See Linking in Self Reported Tax on 
page 82

Overview

Note: This feature was on a separate tab in previous versions of 
OpenForms.
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Self Reported Tax Filing

Use the Self Reported Tax Filing form to complete payment collection 
information, to view totals, interest payments and levies for each Self 
Reported tax record. See Self Reported Tax Filing on page 68.

Self Reported Tax Mailing Index

The Self Reported Tax Mailing Index is used to maintain recipient information. 
In this form, you can maintain general mailing information, such as address, 
type, status, payer information and Inactive account status information. In 
addition, you can specify an address to forward the mail to over a set time 
period. See Self Reported Tax Mailing Index on page 84.

Self Reported Tax Occasional Filing

The Self Reported Tax Occasional Filing form ideally can be used for the 
occasional or “seasonal” business. See Self Reported Tax Occasional Filing 
on page 89.

Self Reported Tax Zero Filer

Self-Reported Tax filings are made according to your Reporting Period 
settings. Occasionally, there will be periods where you will have nothing to 
report; i.e. no sales, collected duties or deductions to report. In such 
instances, a “zero filer option” is available in the Self-Reported Tax Data Entry 
form. This option, when selected and saved under the Tax Filing tab of the 
Business Tax OpenForm, will set all parameters to zero. See  Option for “Zero 
Filer” on Data Entry Form on page 72. New to release 6.0 is a Quick Entry 
feature. See Zero Filer Quick Entry on page 73.

Modify fields of Self Reported Tax Categories Form

The fields on forms can require varying amounts of information. At times the 
space, i.e. the dimensions of default field that are provided by the system may 
not be sufficient; e.g. address fields where lengths can vary. Depending upon 
business requirements, it is possible to adjust the width and height of fields 
that are displayed to the end user. The control parameters required are 
entered in the Self Reported Tax Categories form under the Fields tab. In the 
GNA, the following parameters are available to be modified:
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Self-Reported Tax
Width: This is the width of the field in pixels. No unit should be specified. If no 
value is entered, the system default width will be used.

Height: The value entered will control the height of the field in pixels. No unit 
should be specified. If no value is entered, the system default height will be 
used. See Modify fields of Self Reported Tax Categories Form on page 42 for 
details.
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Self-Reported Tax
Configuring Govern Self Reported Tax
The following steps will explain the configuration process of the Govern Self 
Reported Tax module.

Administration Settings

In Govern, administrative settings are configured in the applications System 
Registry (Table: SY_REGISTRY). Administrative forms that are used to 
configure the Business Tax module can be found in the Govern New 
Administration (GNA) Release 6.0 application.

To access the OpenForms General Settings form...

1. In the Govern New Administration (GNA) ribbon, click to select the System 
Parameters tab.

2. Click the General Settings Editor icon (A).

3. In the form, locate the Registry Filter and select Self Reported Tax.

Note: The Govern Self Reported Business Tax module can be configured for 
either an existing database, or to function with a new unpopulated, i.e. 
empty database. The following steps are relevant to both scenarios.
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Configuring Govern Self
Reported Tax
Open Forms General Settings form

OpenForms General Settings parameters

In the Open Forms General Settings form, you will find the parameters for the 
Missing Filing Process.

Check Change Date (Create Missing Filing Process): When the 
Check Change Date (Create Missing Filing Process) option is selected, the 
process will take the ST_MASTER. CHANGE_DATE as the Starting Date and 
only creates filing records back up to that date.

Check Link to Permits (Create Missing Filing Process): Select this 
option if the Self-Reported Tax (ST) account is linked to the Property 
Management (PM) system. The process will take the PM_MASTER. 
START_DATE as the Starting Date and only creates filing records back to that 
date.

Controlling Account Number Increment

Increment: Entering a value into the Increment parameter will allow you to 
control the number that is added to generate each subsequent account.

For example, if your Next Account Number is 00000201 and you have entered 
an Increment of 100, the next account number to be automatically generated 
will be 00000301. This incrementing is observed with each new account 
generated.
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Self-Reported Tax
Add Weekend, Holidays to Due Date: Selecting the Add Weekend, 
Holidays to Due Date option will factor in weekends and holidays in due dates. 
This can impact the calculation of interest and other calculations

Accounts Receivable Configuration

AR General Parameters

As part of the Self-Reported Tax Setup, you need to set the Accounts 
Receivable General Parameters. See  Accounts Receivable Parameters for 
Self Reported Tax Configuration on page 14.

AR Classes

Another component of the Self-Reported Tax Setup is the creation of Accounts 
Receivable Classes. AR Classes can be linked to the various transaction 
types, to General Ledger, account numbers and to penalty and interest 
computation methods. See  Accounts Receivable Classes on page 17.

Govern Administration Configuration

Department Setup

You need to define the self-reported tax parameters for each department that 
maintains Self-Reported Tax data. See  Department Setup for Self Reported 
Tax on page 19.

Switch for Email Forwarding in Govern Admin

There is a switch in Govern Admin that allows the enabling or disabling the 
address forwarding feature in the Self Reported Tax (ST) module. See 
Enabling the Mailing Index in Govern Admin for details.
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Configuring Govern Self
Reported Tax
Self-Reported Tax Administrative Forms

SRT Copy to Year

The Copy to Year function is used to copy data from one year to the next. The 
system will duplicate the Codes from the user selected available year to the 
year specified. If there is data existing in the year, it will be overwritten.

General Parameters

The first form to set up for the Self-Reported Tax is the General Parameters 
form. This generates the next self-reported tax account number. One is added 
to each subsequent account created. See Self-Reported Tax General 
Parameters.

Category

Use the Self-Reported Tax Category form to create categories for self-
reported tax. You can add penalties and discounts to the categories. Then, set 
up Fields and Levies for each category. See Self-Reported Tax Categories.

General

Penalties and Interests: Define applicable penalties and interests, late 
payment charges and so on. 

Discount: Used to set up any required applicable discounts.

Fields

Use the Self-Reported Tax Fields form for creating computation rules for the 
computing the Self-Reported Tax Categories on the Self-Reported Tax Data 
Entry function. See Self-Reported Tax parameters.

Levies

Use the Self-Reported Tax Levies form to create levy codes for SRT tax levies. 
You can define a levy type and computation method for each levy.
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Self-Reported Tax
Exemptions

Under the Exemptions tab, specify the exemptions that are to be applied to 
Levy Types and can be calculated either before or after the tax calculation.

Multimedia Codes

Define the multimedia codes for the document types that are to be used for 
the ST categories. If required mandatory submission of a document can be 
enforced for a submission.

Periods

Use the Self-Reported Tax Periods form to create periods in order to define 
the times that the self-reported tax is due. See Self Reported Tax Periods on 
page 44 for details.
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Configuration
 Self Reported Tax Configuration

Accounts Receivable Parameters for Self 
Reported Tax Configuration

As part of the Self Reported Tax configuration process, there are parameters 
in the A/R module that will need to be configured.

To access the Accounts Receivable General Parameters form...

1. Launch the Govern New Administration (GNA) Release 6.0.

2. Under the Application Configuration menu, locate the Accounts 
Receivable icon; click the triangle to beside the icon to display the menu.

3. Select the A/R General Parameters menu.

The required parameters are in various sections of the form, 3, 4, 5, and 6.
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Self-Reported Tax
Account Receivable by Fiscal Year...

In Govern the Self Reported Tax module is one of the modules that users will 
need to configure to be in line with their A/R transactions. The options are to 
have a new A/R account created each fiscal year, i.e. each year the account is 
closed and a new one is created for the new year. modules that work like this 
are the Govern Tax and Assessment subsystems. Alternatively, the default 
setting for Self Reported Tax is, one account is used for saving the records 
with no fixed end date. An example of such a subsystem is Utility Billing. The 
option that is used to determine which method to use is the A/R Master By 
Fiscal Year. This option is found in the General Settings Parameter form in 
GNA. 

To access the Accounts Receivable General Parameters form...

1. Launch the Govern New Administration (GNA) Release 6.0.

2. Under the Application Configuration menu, locate the Accounts 
Receivable icon; click the triangle beside the icon to display the menu.

3. Select A/R General Parameters.

4. In the A/R General Parameters, locate the Related Subsystem 
Parameters group.

5. Select Self Reported Tax to display the Self Reported Tax Parameters 
group.

6. In the group locate the A/R Master by Fiscal Year option.

Click to enable the option if you would like to have your A/R account closed at 
the end of each Fiscal year and a new account create at the beginning of the 
next year.

Option to Bypass Self-Reported Tax Re-application of 
Funds

When an overpayment is made to an SRT account to settle a period. the 
excess, or overpayment will, by default, be applied to another SRT period. To 
avoid this, the excess amount can be saved as an Open Credit Transaction 
(OCT) in the system.

To bypass the funds reapplication in the A/R General Parameters form...

1. In the A/R General Parameters, locate the Related Subsystem Parame-
ters group.
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Self Reported Tax
Configuration
2. Select Self Reported Tax to display the Self Reported Tax Parameters 
group.

3. On the left hand side, locate the Bypass ST funds reapplication option.

Click to enable the option if you would like to save any overpayment amounts 
as an Open Credit Transaction (OCT) in the system.
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Self-Reported Tax
Accounts Receivable Classes
To complete the Self Reported Tax setup, Accounts Receivable classes will 
need to be created. These classes can be linked to the various transaction 
types, General Ledger (G/L) account numbers, and to Penalty and Interest 
computation methods.

To access the A/R Classes form...

1. Launch the Govern New Administration (GNA) Release 6.0.

2. Under the Application Configuration menu, locate the Accounts 
Receivable icon; click the triangle beside the icon to display the menu.

3. Select A/R Class.
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Accounts Receivable
Classes
Required A/R Classes

You need to define a minimum of six AR Classes, and associate them to the 
AR Transaction Types and Methods, indicated in the following table:

For further details on the Accounts Receivable Transaction Types, refer to the 
Govern Accounts Receivable Release 6.0 user guide.

Transaction Type Transaction Type Definition
Penalty / Interest 
Method

Invoice/Billing A list of itemized amounts for 
goods and services.

Self- Reported Tax

Adjusted Bill A modification made to a Partial 
Billing record.

Self- Reported Tax

Discount A reduction on the total value or 
gross amount

No Interest Method

Penalty A charge applied on delinquent 
accounts.

No Interest Method

Interest A charge, usually a percentage, 
applied on delinquent bills or 
borrowed money.

No Interest Method

Adjustment A modification made on an 
account or bill.

Self- Reported Tax
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Self-Reported Tax
Department Setup for Self Reported Tax
The following parameters will need to be setup for each department that 
maintains Self-Reported Tax data.

To access the Department Maintenance form...

1. Launch the Govern New Administration (GNA) Release 6.0.

2. Under the System Parameters menu (A), locate the Department 
Maintenance icon (1); click the icon to display the Department 
Maintenance form.

3. On the left hand side (2), select a department that will have access to Self 
Reported Tax data. 

4. On the right hand side locate the A/R Subsystems Allowed group.

5. Select Self Reported Tax.

6. Click Save.
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Self Reported Tax General Parameters
When configuring the Self Reported Tax module, the first form to configure is 
the Self-Reported Tax section of the OpenForms General Settings form.

To access the Self Reported Tax parameters in the Govern New 
Administration (GNA):

1. Launch the GNA.

2. Select the Application Configurations tab.

3. Click Business Tax > General Parameters; the SRT General Parameters 
tab is displayed.

4. In the SRT General Parameters form, locate the parameters that are used 
to configure the SRT module.

ST General Parameters Configuration Options

With the exception of the Add Weekends, Holidays to Due Date option, all of 
the following parameters are found in the SRT General Parameters form.

• Next Account Number - Informational field; cannot be modified. 
• Check Link to Permits (Create Missing Filing Process) - See Check Link to 

Permits / Check Change Date options on page 33
• Check Change Date (Create Missing Filing Process) - See Check Link to 

Permits / Check Change Date options on page 33.
• Add Weekends, Holidays to Due Date - See Managing Weekends and 

Holidays on page 33.
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 Control Account Number Increment

The General Parameters window automatically generates the first number for 
self-reported tax accounts. Entering a value into the Increment parameter will 
allow you to control the number that is added to generate each subsequent 
account.

For example, if your Next Account Number is 00000201 and you have entered 
an Increment of 100, the next account number to be automatically generated 
will be 00000301. This incrementing is observed when generating new 
accounts in the Self-Reported Tax Account function. See Account Number 
Increment.

Next Account Number: The Next Account Number parameter is 
informational and cannot be modified at this location.

Increment: Entering a value into the Increment parameter will allow you to 
control the number that is added to the last existing number when generating 
each subsequent account number. See Increment on page 33.

Missing Filers

The SRT Missing Filer process creates empty filing records (new entries into 
the following tables, ST_FILING_MASTER, ST_FILING_FIELDS and 
ST_FILING_LEVY. The records created by this process will be flagged as 
UNFILED, (ST_FILING_MASTER. UNFILED = -1); no data is entered,

In the Govern New Administration, there are two (2) parameters available for 
this process:
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Check Links to Permits (Create Missing Filing Process): During the 
generate missing filer process, the system will see if there are any permits 
linked to the account. If a permit is found, it will generate filing records back to 
the START_DATE value. Refer to the grid Rules for Check Change Date / 
Check Links to Permits on page 22. 

Check Change Date (Create Missing Filing Process): When the 
Check Change Date option is selected, the process will take the 
ST_MASTER. CHANGE_DATE as the Starting Date and only creates filing 
records up to that date. Refer to the grid Rules for Check Change Date / 
Check Links to Permits on page 22.

Rules for Check Change Date / Check Links to Permits

Below are the four (4) possible behaviors that can be displayed by selecting 
combinations of the Check Change Date and/or Check Links to Permits 
options.

Option Check box 
State Behavior

Check Links to Permits 
(Create Missing Filing 
Process)

Not Selected When neither of the two parameters are selected, 
the START_DATE that is used for generation is 
taken from ST_PARM_PERIOD_DETAIL. The 
missing periods will be generated back to the 
START_DATE (Table: 
ST_PARM_DETAIL.START_DATE).

Check Change Date 
(Create Missing Filing 
Process)

Not Selected

Check Links to Permits 
(Create Missing Filing 
Process)

Selected Selecting only Check Links to Permits will take 
the START_DATE used for generation from the 
linked permit. The missing periods will be 
generated back to the START_DATE (Table: 
PM_MASTER.START_DATE)Check Change Date 

(Create Missing Filing 
Process)

Not Selected

Check Links to Permits 
(Create Missing Filing 
Process)

Selected The START_DATE of the Check Change Date is 
compared to that of the Links to Permits. The 
highest of the two START_DATES is used for the 
missing periods generation. The missing periods 
will be generated back to the START_DATE.Check Change Date 

(Create Missing Filing 
Process)

Selected
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Add Weekend, Holidays to Due Date: When the calculation for the due 
date (last day of the period) is performed, when this option is selected 
weekends and holidays, i.e. Saturdays and Sundays, and any days that were 
specified as holidays in the Holiday Calendar will be included in the total 
number of days. The Due Date corresponds to the last day of the period.

Check Links to Permits 
(Create Missing Filing 
Process)

Not Selected When the Check Change Date option is 
selected, the START_DATE that is used for 
generation is taken from 
ST_MASTER.CHANGE_DATE. The missing 
periods will be generated back to the 
START_DATE.

Check Change Date 
(Create Missing Filing 
Process)

Selected

Option Check box 
State Behavior
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Self Reported Tax Categories
Use the Self-Reported Tax Categories form to create categories for self 
reported tax. You can add penalties and discounts to the categories. Then, set 
up Fields and Levies for each category.

To access the Self Reported Tax Category form:

1. Launch the Govern New Administration (GNA).

2. Under the Application Configurations menu, select Business Tax > 
Categories...

Reviewing Records

Existing or newly created records are viewed on the left hand side in a list. 
Click to select a records, its properties will be displayed in the forms
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Self Reported Tax Categories command buttons

Create a New Item: Click to create a new Self Reported Tax (ST) category.

Cancel Changes: After creating a new category or when making changes 
to an existing one, the Create a ne w item button will change to the Cancel 
Changes icon. Click to cancel changes to a newly created or existing category.

Save the Current Item: Click to save a category or changes.

Delete: Select and click Delete to remove a category.

Self Reported Tax Categories tabs

General tab

The General tab contains the parameters required to configure Penalties and 
Interest, and Discounts. See Self Reported Tax Category - General tab on 
page 26.

Fields tab

Use the Self Reported Tax Fields form to create data entry fields and 
computed fields that follow custom computation rules on the Self Reported 
Tax function. See Modify fields of Self Reported Tax Categories Form on 
page 42.

Levies tab

Click the Levies tab to create tax levies for Business Tax. You can define a 
levy type and computation method for each levy. See Levies and Exemptions 
tabs on page 78.

Exemptions tab

To add exemptions by categories, click the Exemptions tab. See Levies and 
Exemptions tabs on page 78.

Exit: Click Exit to close the form; you will be prompted if there are unsaved 
changes.
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Multimedia Codes tab

The Multimedia Codes tab is used to specify the Multimedia file types 
accepted by the system, and if a submission is mandatory (Is Required) with 
the record.

Setting up Self Reported Tax Categories

To set up Self Reported Tax categories:

1. In the Categories form, click Create a New Item to clear the form.

2. Enter a Category Code.

3. Enter a Short Description and Long Description. This information is 
saved to VT_USR_ST_CATEG.

4. Select a Department.

5. When the category is not to be made available on the Web for the eGov 
Web Portal, click to select the Hide on Web option.

Self Reported Tax Category - General tab

Penalties and Interest tab

6. Under the Penalties and Interest tab, Enter penalties and interest 
charges, as percentages, and select AR Class Codes for each of the 
following:

7. Enter penalties and interest charges, as percentages, and select AR Class 
Codes for each of the following:
• Late Filing
• Minimum Late Filing
• Late Payment
• Incorrect Filing
• Incorrect Payment

Note: The Multimedia file types that are supported by the system will vary 
depending upon administration setup.

Note: Self Reported Tax information is saved by Department.
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• Negligence Penalty
• Penalty for a Not Sufficient Funds (NSF) check.
• Monthly Interest

8. Select an A/R class for adjustments.

9. Enter an amount in the Minimum Late Filing text box, if applicable.

Discount tab

To create a discount, you will need to do one of the following:

• Create a fixed amount, by selecting Fixed Percentage. Enter the fixed 
percentage value.

OR

• Set up different percentages, by not selecting Fixed Percentage. Enter a 
percentage of a first amount, enter the amount. Now enter a percentage 
for the remaining amount.

10. Enter a maximum amount, in dollars, for the discount if applicable.

11. Click Save the current item on the Category tab.

12. Repeat this procedure for each category created.

Penalties and Interest tab

Monthly Late Payment Penalty group: You are able to specify a monthly 
penalty as an option when you are creating Business Tax categories. Three 
(3) fields are available in the ST_PARM_CATEG table.

Structure of ST_PARM_CATEG Table

The following is the structure of the ST_PARM_CATEG table.

Field Name Data Type Description

PEN_METHOD Number Value = -1 if Monthly late payment penalty 
applies; Value = 1 otherwise

PEN_MAX_PCT Number Maximum Late Payment Penalty 
Percentage.

PEN_MAX_MONTH Number Maximum Number of Months of Late 
Payment Penalty.
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Click to display the option in this group. They allow you to enable the Monthly 
Late Payment option; when selected, you may specify the Maximum number 
of months that the Penalty is applied.

1. In the Business Tax Categories form, click New to clear the form.

2. Select a department.

3. Enter a Category Code, Short Description and Long Description. This 
information is saved to VT_USR_ST_CATEG.

4. Enter penalties and interest charges, as percentages, and select AR Class 
Codes for each of the following:
• Late Filing
• Late Payment
• Incorrect Filing
• Incorrect Payment
• Negligence Penalty
• Penalty for a Not Sufficient Funds (NSF) check.
• Monthly Interest

5. Select an A/R class for adjustments.

Self-Reported Tax Exemptions by Categories

Occasionally, it may be necessary to apply exemptions to Self-Reported Tax 
(ST) records. The Exemptions tab of the Self Reported Tax Categories form 
allows you to configure exemptions to each of your SRT categories. In 
addition preferences can be set for when the calculation will apply, before or 
after the tax calculations.

Note: The value that is entered in the Maximum Interest and Penalty value 
will be overridden by the value entered in the Minimum Late Filing 
parameter in the Self Reported Tax Categories form; In the Govern 
New Administration (GNA): Application Configurations > Business Tax 
> Categories.

For Example: If you owe $100.00, and a maximum interest and 
penalty charge is set to 25%, your penalty amount would be $25.00 
Should the Minimum Late Filing charge be set to $50.00 in the Self 
Reported Tax Categories form, regardless of the calculation 
percentage, you will be charged $50.00.
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You should first set up the A/R Classes for the Self-Reported Tax Categories 
in the Govern New Administration (GNA). For steps to create SRT classes, 
see Accounts Receivable Classes on page 17.

To set up exemptions in the Govern New Administration (GNA):

1. Select Applications Configurations (tab) > Business Tax > Categories.

2. In the Self-Reported Tax Categories form, create a new category or select 
an existing category.

3. Complete the form; enter the applicable percentages and select A/R 
Classes in the Penalties and Interest group.

4. If applicable, enter a Minimum Late Filing charge.

5. Click the Exemptions tab to configure exemptions.

6. Complete the parameters of the Category Exemptions form.

Exemptions can be applied by amount or by percentage. The exemption can 
also be applicable before or after the tax calculation.

7. Select whether the exemption will be by amount or percentage in the 
Exemption By group.

8. Select the point at which the exemption is applicable, before or after the 
tax calculation; make your selection in the Exemption Applicable group.

9. Click Save to complete your setup and return to the Business Tax 
Categories form.

Late Payment Monthly Penalty Option

You are able to specify a monthly penalty as an option when you are creating 
your Self-Reported Tax categories. As a result of this feature, three (3) fields 
have been created in the ST_PARM_CATEG table. This option is enabled in 
the Govern New Administration (GNA).

To enter a Monthly Penalty for an SRT category in GNA.

1. Select Applications Configurations (tab) > Business Tax > Categories.

Note: The value that is entered in the Minimum Late Filing Charge parameter 
overrides any settings that may have been configured in the individual 
ST A/R Classes.
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2. In the Penalties and Interest tab, click to select the Monthly Late Payment 
Penalty option.

3. Enter parameters for a Maximum number of months of late payment 
penalties.

Table Modifications:

The following modifications have been made to the ST_PARM_CATEG table.

Structure of ST_PARM_CATEG Table

The following is the structure of the ST_PARM_CATEG table.

Field Name Data Type Description

PEN_METHOD Number Value = -1 if Monthly late payment penalty 
applies; Value = 1 otherwise

PEN_MAX_PCT Number Maximum Late Payment Penalty 
Percentage.

PEN_MAX_MONTH Number Maximum Number of Months of Late 
Payment Penalty.
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Self Reported Tax Parameters
Use the form under the Business Tax Category Fields tab to create data entry 
fields and computed fields that follow custom computation rules on the 
Business Tax Data Entry function.

To access the Business Tax Fields tab:

1. Launch the Govern New Administration (GNA).

2. Under the Application Configurations menu, select Business Tax > 
Categories.

3. In the Business Tax Categories form 

Missing Filing Process

The Missing Filing process is used to generate missing ST (Business Tax) 
filings in a “metered” manner, for end users. In govern 6.0 filings are 
automatically created when the parameters of an account are defined.

eGovern behavior with Un-filed Accounts

Changes have been made to how the system handles Unfiled Accounts that 
are related to Self Reported Business Tax. During the set year, when a user in 
a profile performs a search, the system will verify if any resulting accounts are 
unfiled, i.e. (ST_FILING_MASTER. UNFILED = -1). If no filings are 
outstanding, the system will display a status message at the top of the 
interface. When outstanding filings are found, the user will be redirected to the 
filing page. A navigation button has been added to facilitate navigation back to 
the home page. Users that want to customize the displayed message, can do 
so with the Resource Editor in GNA Release 6.x. The associated key is the 
following:

WB > WEB_SRT_SELFREPORTEDTAX > CVSSELECTEDACCOUNTS. 
Refer to the Govern New Administration (GNA) Release 6.0 user guide for 
details about making modifications using the Resource Editor.
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Self Reported Tax Account Number 
Parameters

When configuring the Business Tax module, the first form to configure is the 
Business Tax (SRT) General Parameters form.

To access the Business Tax General Parameters form:

1. Launch the Govern New Administrator (GNA).

2. In the GNA ribbon, select the Application Configurations tab.

3. In the Govern Tax group, click the Business Tax icon to display the 
available forms in the drop down menu.

4. Select SRT General Parameters..

Control Account Number and Increment

Next Account Number: This parameter displays the next account number 
that will be generated by the system. The account number is increased by the 
value that is entered in the Increment field on this form or in the OpenForms 
General Settings form. See Increment below, or Increment on page 21 for 
details.

Overview
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Increment: The General Parameters window automatically generates the 
first number for Business tax accounts. Entering a value into the Increment 
parameter will allow you to control the number that is added to generate each 
subsequent account.

For example, if your Next Account Number is 00000201 and you have entered 
an Increment of 100, the next account number to be automatically generated 
will be 00000301. This increment is observed when generating new accounts 
in the Business Tax Account Maintenance function. See Self Reported Tax 
Account Maintenance on page 63

Check Link to Permits / Check Change Date options

Check Link to Permits: Select the Check Link to Permits, if the Business 
Tax (ST) account is linked to PM, the process will take the Starting Date as 
the value in PM_MASTER. START_DATE and only creates filing records back 
to this date.

There are four (4) possible behaviors that can be displayed by selecting either, 
both, or none of the two options. Refer to the grid of Rules for Check Change 
Date / Check Links to Permits on page 22.

Check Change Date: When the Check Change Date option is selected, the 
process will take the ST_MASTER. CHANGE_DATE as the Starting Date and 
only creates filing records back up to that date.

Selecting both options...

If both of the above options, Check Link to Permits and Check Change Date, 
are selected, the process will take the larger of the two dates as the Starting 
Date; i.e. the more recent of the two dates, and only creates filing records 
back to that date.

Managing Weekends and Holidays

Add Weekend, Holidays to Due Date: When the calculation for the due 
date (last day of the period) is performed, when this option is selected 
weekends and holidays, i.e. Saturdays and Sundays, and any days that were 
specified as holidays in the Holiday Calendar will be included in the total 
number of days. The Due Date corresponds to the last day of the period.
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General Settings Parameters to Create Missing Filings

Create Missing Filings: The Business Tax - Create Missing Filer batch 
process is used to pro actively generate the Business Tax forms that will be 
filed for a given period. When following this process a form can be pre-
generated for the period required for your process; monthly, quarterly, etc. 
Users will only be able to file the period that you have generated. This method 
offers the advantage of minimizing errors associated with users filing for the 
wrong period when they have multiple periods available to select from. Self 
Reported Tax Periods on page 44 for details about periods.
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Self Reported Tax Editor
The Business Tax form is used to design the layout of SRT entry forms in the 
SRT OpenForm. To assist in the design process, after each field has been 
positioned, a preview of the layout can be seen under the Preview tab..

To display the Business Tax Editor...

Note: The preview is an approximation of the layout and not a true What You 
See Is What You Get (WYSIWYG) representation of the designed 
layout.
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1.In the GNA ribbon, select the 
Application Configurations tab.

2.In the Govern Tax group, click 
the Business Tax icon to display 
the available forms.

Options include:

•Copy to Year
•General Parameters

• Categories
• Categories Form Setup 
• Periods

3. Select the General Parameters form.

4. Note the Next Account Number field.

5. If an increment value is required for each new account number, it can be 
entered in the Increment parameter.

6. Click the Check Link to Permits and / or the Check Change Date 
options.

7. Click the Save icon or use the Ctrl + S keyboard combination, to save your 
settings. 

Business Tax Editor Command Buttons

Save: Click Save to save any changes made to the form.

Business Tax Editor Parameters

OpenForms Settings group

The following parameters are used to control the positioning of the parameters 
that are filled out on an ST Business Tax form.
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Row / Column: The Row and Column parameters are used to specify the 
horizontal / vertical positions of the field.

Column Span: Column Span allows you to specify the number of columns 
that the field will spread over.

Show label on top of the control: When this option is selected, the text 
label of the field will be presented on top of the field.

No label for this field: Select this option to display the field without any text 
label.

Is Hidden: Select the Is Hidden option to hide the row; see Adding Blank 
Spaces and Columns in a Layout on page 41.

Tab Sequence: Enter a tab sequence number to control the order that the 
fields are cycled through when the user presses the Tab key. See Changing a 

WARNING: Always assign a Row and Column position value otherwise the 
values in these fields will not be computed. This can lead to 
errors in calculated values. This rule is regardless of whether the 
field is hidden or not.
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Form Tab Sequence on page 43.

Web Site Settings group

Users of the eComponents that provide Self Reporting Tax, (i.e. eRemittance), 
reporting functionality to their clients can also control the presentation of these 
forms. These parameters will help to specify how the forms will appear 
through a web browser. Refer to the eRemittance section of the Govern 
eGovern - Public Self Service Portal release 6.0 user guide for additional 
details.

Row / Column: The Row and Column parameters are used to specify the 
horizontal / vertical positions of the field.

Note: The default for the appearance of labels is on the left hand side of the 
parameter.

WARNING: Always assign a Row and Column position value otherwise the 
values in these fields will not be computed. This can lead to 
errors in calculated values. This rule is regardless of whether the 
field is hidden or not.
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Column Span: Column Span allows you to specify the number of columns 
that the field will spread over.

Show label on top of the control: When this option is selected, the text 
label of the field will be presented on top of the field.

No label for this field: Select this option to display the field without any text 
label.

Required control on the web site page: There are instances when a 
field may be required to be completed prior to proceeding to the next page or 
section. This could be a Completed By field that acts as a signature, or a 
mandatory date.

Customizing Address fields with the SRT Editor

For an SRT report, part of the report will require the entry of the users address. 
An address can usually require a Street address, a secondary Apartment or 
Suite number and possibly a third field. Additional fields would be needed for 
the City, State, and Zip Code. These fields can be lined up in the same 

Note: Column widths when specifying spans values are determined by the 
width of the largest object in each of the columns.
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column, The street address parameter will have the label displayed on top of 
the field and the secondary apartment number or suite parameter can be 
displayed without a label. The Layout would look approximately like the 
following, note that the address fields span over 2 columns: 

To have your fields reproduce the above...

1. In the GNA select Setup > OpenForms Configuration > Business Tax Edi-
tor.

2. In the editor, enter the year and select the Department and Category that 
contains the field that will be in the SRT form.

3. Click and select ADDRESS1 under the Business Tax Definition List 
column.

Note: To reproduce the following example, you will need to have created an 
SRT category with the required address fields.
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4. For ADDRESS1 enter 1 and 1 in the Row and Column parameters; the 
column Column Span should be set to 2 (columns).

5. Configure ADDRESS2 as 2 and 1 for the Row and Column parameters, 
but select the No label for this field option; again set the Column Span 
to 2.

6. Repeat the last step for ADDRESS3, noting that the Row and Column 
values are 3 and 1; be sure to select the No label for this field option.

7. You can click the Preview tab to preview the layout.

8. Repeat the previous steps for the City and State fields, remembering to 
increment the numbers entered for the Row. 

This Business Tax (SRT) editor should be used by all administrators that 
prepare SRT forms required for filing periodic reports.

Adding Blank Spaces and Columns in a Layout

The Business Tax Editor allows the insertion of blank lines and columns as a 
means of creating visual breaks to enhance a form layout.

To create a a blank line...

1. Open the Business Tax editor.
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2. In the OpenForms Settings group, specify a new row or column.

3. Click to select the Is Hidden option.

4. Click Copy all OF settings to Web (1), to ensure that the sequence is 
repeated in the eComponent Web form.

Modify fields of Self Reported Tax Categories 
Form

NEW! The fields on forms can require varying amounts of information. At 
times the space, i.e. the dimensions of default field that are provided by the 
system may not be sufficient; e.g. address fields where lengths can vary. 
Depending upon business requirements, it is possible to adjust the width and 
height of fields that are displayed to the end user. The control parameters 
required are entered in the Self Reported Tax Categories form under the 
Fields tab. In the GNA, the following parameters are available to be modified:

Width: This is the width of the field in pixels. No unit should be specified. If no 
value is entered, the system default width will be used.

Height: The value entered will control the height of the field in pixels. No unit 
should be specified. If no value is entered, the system default height will be 
used.

TIP: When modifying the layout, use the Preview tab to verify your layout. 
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Changing a Form Tab Sequence

Using the tab key the user is able to sequentially jump from field to field, 
depending upon the sequence that was set by the form designer. 

To change the tab sequence of a field...

1. In GNA open the Business Tax editor.

2. In the OpenForms Settings group, enter the new sequence number in the 
Tab Sequence: field.

3. Click Copy all OF settings to Web, to ensure that the sequence is 
repeated in the eComponent Web form.

TIP: When changing the tab order, review the previously existing tab order. 
When completed, use the preview 
Page 43 © 2015 Harris Govern



Self Reported Tax Periods
Self Reported Tax Periods
Use the Self-Reported Tax Periods form to create periods in order to define 
the period that the Self Reported tax is due.

Users of the Self Reported Business Tax module will notice a change in the 
"Detail for Period ..." parameter in the Period form. Now there are three (3) 
dates that will need to be provided for each period:

Start Date: The start date for the period

End Date: This is the end date for the period

Due Date: The date in which the filing is due.

Noted Changes and Impact

There is a change to (Table: ST_PARM_PERIOD). Use of the (Table: 
ST_PARM_PERIOD) for Govern for Windows was changed to the newer 
(Table: ST_PARM_PERIOD_DETAIL); added in Govern release 5.1.

Users that are migrating from Govern for Windows Release 10.8 to Govern 
Release 6.0 should note the following changes:

There is a synchronization process that occurs when the DUE_DATE value in 
(Table: ST_PARM_PERIOD), i.e. in Govern for Windows was modified; the 
table is synchronized with Govern release 6.0's (Table: 
ST_PARM_PERIOD_DETAIL).

Note: In Govern release 6.0 although (Table: ST_PARM_PERIOD) is still 
present it is now only being used as an access point to the details that 
are now in (Table: ST_PARM_PERIOD_DETAIL.).
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Search Pane

The Predefined Searches pane is the main user interface for performing 
searches on the database. As searches can produce numerous results, these 
results can be controlled with the value specified in the Max. Records 
parameter in the Ribbon. See  About Maximum Records on page 38 for 
details.

Predefined Searches (The Search Interface)

About Searches

Predefined Searches are queries that have been preset for the user. When a 
search is performed, you are querying the database based upon your 
specified criteria. For example, a search by Parcel ID (P_ID) will return all 
records with a P_ID or a P_ID that matches a specified parameter. When the 
Max. Records parameter is used, i.e. a value of 25 is specified, only the first 
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25 records are used. If there are more records, they are discarded. Additional 
sorting can occur, but only on the records obtained. See  Sorting Search 
Results by Column Heading on page 55 for details.

Treeview Synch

NEW!  In Govern for VB6, external tables (PC_EXTERNAL, NA_EXTERNAL, 
and PM_EXTERNAL), were used by external applications and reports to 
automatically know the current recordset and currently viewed parcel. In 
Govern release 6.0 and upwards, these external tables are being phased out 
and the functionality provided by them has been reproduced.

The Treeview sync. feature saves the contents of the current profile in (Table: 
USR_SAVED_DATASETS) with a "Saved Dataset" name of "AUTOSAVE" 
under (Column: USR_SAVED_DATASETS.SAVED_SET_NAME). Should a 
profile be changed, the dataset loaded in the Treeview will be automatically 
synchronized to (Table: USR_SAVED_DATASETS).

This feature recreates the functionality provided by the three (3) external 
tables that were used in Govern for Windows, (Tables: PC_EXTERNAL, 
NA_EXTERNAL, and PM_EXTERNAL). For example users could run a batch 
process on a saved external dataset as opposed to a set range.

Enabling “Synchronize Dataset Treeview”

This feature is enabled in the User Registry through the User Registry 
Manager. The Options button is located below the Govern suite button in the 
Govern User Interface. See User Registry in the Govern 6.x user guide for 
details.

1. Click the Options button; click Options.

Note:  In release 6.0 a simultaneous save will be made to (Table: 
PC_EXTERNAL) and (Table: USR_SAVED_DATASETS), Tables 
NA_EXTERNAL and PM_EXTERNAL are no longer supported. 

In release 6.1, all three (3) tables PC_EXTERNAL, NA_EXTERNAL, 
and PM_EXTERNAL will not be supported.
• PC_EXTERNAL (Supported in release 6.0; not supported in 

release 6.1)
• NA_EXTERNAL (Not not supported in release 6.0 and 6.1)
• PM_EXTERNAL (Not not supported in release 6.0 and 6.1)
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2. In the Registry Manager form, verify that the Registry Filter is set to User 
ID.

3. Under the Section Name column, locate Synchronize Dataset Treeview; 
click to select the option under the Key Value column.

4. Click Save to save your changes.

When you return to the Govern interface, the Treeview Sync. icon will be 
enabled. This is a toggle, i.e. ON/OFF button that will enable or disable the 
feature.

As indicated above, all data will saved in (Table: USR_SAVED_DATASET). 
Associated columns are as follows:

Search Pane - Command Buttons

 Search for Results: Click this icon to perform your search based upon 
your selected criterions.

Column Description

USR_ID User ID

SAVED_SET_NAME By default will be AUTOSAVE

REF_TYPE "P_ID", "NA_ID", etc. Based on the profile Key Type

SORT_SEQ Order in the Treeview

IS_CURRENT TRUE if the current item in the Treeview

Note: All data will be saved based on the Key Type of the profile. This is 
done so as to support multiple Key Types at the same time.
• The data is not saved by profile, so the synchronization for a Key 

Type will be done on the last active profile using that key type.

The desired behavior when there is more than one Treeview dataset 
for the same ID Type is to perform a reload when the user switches 
from one instance to another.
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  Select / Deselect All: When search results are obtained, they are 
listed in the search pane. By default the results are all selected. Click the 
Deselect All icon to deselect all results; this will allow you to select only select 
records.

 Clear: Click Clear to clear the Search Results pane of all records.

 Load Selected Parcels: When this icon is selected, the search results 
records are transferred to the Dataset Treeview pane.

 Add to the Search Results: To add or append the currently listed 
search results to the results that are listed in the Dataset Treeview pane, click 
this icon.

 Clear and Save to External Tables: Click to save the search results 
to one of the three (3) External tables (i.e. PM_EXTERNAL, NA_EXTERNAL, 
and PC_EXTERNAL).

 Append to External Tables: Click to append the search results to one 
of the three (3) External tables (i.e. PM_EXTERNAL, NA_EXTERNAL, and 
PC_EXTERNAL).

 Print: Click Print to display the Print dialog box and print out the results 
of your query to your default Windows printer.

Note: The Select All and Deselect All icons alternate depending on whether 
all search results are selected, or deselected.

TIP: When you enter information into any of the search parameters, clicking 
Enter will start the search and automatically load results to the 
Treeview.
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 Export to Excel: Click to export the results of your query to an 
unformatted Microsoft Excel file. See Export Search Query Results to a 
Microsoft Excel File below for details.

To restore the search form...

1. Click the View tab in the Ribbon.

2. Under the predefined Searches section select one of the Groups or 
Styles searches.

3. When the search form appears, it will not be in auto-hide mode. Click the 
Auto Hide (Pin) icon to restore the form to auto-hide mode.

Export Search Query Results to a Microsoft Excel File

After performing a search query, you may want to further analyze or 
manipulate the records that were retrieved, e.g. review the tax map numbers 
or certificate numbers, etc.

To export query results to a Microsoft™ Excel file...

1. Move your pointer over the Predefined Searches auto-hide pane.

2. Complete the necessary parameters and click the Search icon to perform 
a search.

3. Click the Export to Excel button.

4. When the save dialog box appears; specify the name of the Excel file and 
the location that it will be saved in.

5. Once a name has been given, click Save to save the file.

Note: This feature will only work when Microsoft Excel is installed on the 
system that Govern for Windows is installed on. Users must have a 
valid license for Microsoft Excel.
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6. Next you will be given the option to open the file immediately in Excel; 
clickYes to open the file in Excel.

The records that are exported to Excel will not be formatted, i.e. only default 
fonts and alignments will be used.

Search Command button grouping

The Search Pane command buttons are grouped for clarity and to 
accommodate the command buttons with functionality that is related to the 
mobile version of Govern. There are two (2) groups of command buttons; 
Search-related buttons, and Output-related buttons, 

Note: This feature requires that a version of Microsoft Excel must be 
installed on the same system that Govern for Windows is installed on. 
Users must obtain a valid license for Microsoft Excel.
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Search Types

Depending on the search type that is selected, the Search Criteria pane will 
display the corresponding parameters.

Searches in Govern

The search process is one of the key functions in Govern. The search function 
allows you to retrieve datasets from the database. Further actions such as 
creating permits, attaching messages, generating licenses, generating mailing 
lists, etc. can then be performed on the records in these datasets.

Searches are preset queries that are submitted to the database.

To perform a search...

1. Click Pre-defined Searches in the Ribbon.

2. In the drop-down menu, click Groups search or Styles search.

3. In the Predefined Searches form, click Property Search to view the drop 
down menu.

4. Select Property Search (A).
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5. Under Property Search are options to select a search criteria; select By 
Tax Map.

A note to Users accessing Govern Remotely 

6. Click the Search icon.

7. When the search is complete, the results are displayed in the Search 
Results pane (C).

TIP: When using Predefined Searches press the Tab key to quickly move 
your cursor from field to field for quick entry.

Note: Users should note that parameters with field masks that are designed 
to accept hyphen separated entries entries, e.g. Telephone Numbers, 
Tax Maps, will display in OpenForms as a parameter with individual 
fields. These individual fields can be accessed with the tab key .
The Field Mask would look like the like the following  “XXX-”XXX-
XXX-X”, each of the grouped X’s are separated. Users that are 
accessing Govern over a Remote Link, e.g. VPN should pay  
attention to the tab sequence when pressing the Tab key to jump to 
the next parameter. Over a remote connection, in the Tax Map 
parameter, the tab key will not move the cursor to the next field of the 
Tax Map number, rather it will jump to the Include Inactive parameter 
(1).  This behavior only applies to remote connections to Govern.

Note: When you enter information into any of the search parameters, click 
Enter to start the search; search results will be automatically 
transferred to the Treeview. 
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8. Click the option for Load to the Search Result. The results are loaded into 
the Dataset Treeview pane; you can also populate the Dataset Treeview 
automatically by selecting any parameter and clicking on Enter on your 
keyboard.

Search Criteria

The Search Criteria will display the search parameters that have been 
configured with the Search Type.

Note: Only a maximum of 25 search results are displayed; this is can be 
modified under the Options > Max. Records in the ribbon.
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Search Result Pane

When a search is performed, the Search Results pane displays the results in a 
grid below the Search and Search Criteria areas.

Reposition

NEW! Previously, when performing a search of records with the same NA_ID 
but multiple ST Account numbers, when you copy the record to the Treeview, 
the system would only select the first account. Now the selected record will be 
sent to the Treeview. (Available in release 6.0.1503)

Hibernate Mode

NEW! This behavior of selecting only the first account also applies to the 
Hibernate process. As Govern is restored from a hibernation if a second or 
third account is selected before hibernation, when the application is restored, 
although the NA_ID is correct, only the first account will be displayed.

Transfer Individual Files to the Treeview

At times you may require a single file to be loaded / displayed in the Dataset 
Treeview. This situation can arise when you have multiple results in your 
Search Query Results dataset. and the requirement is to look at each record 
one at a time.

To load a single record into the Dataset Treeview...

1. Place your mouse pointer over the Pre-defined Searches auto-hide tab; 
complete the parameters to perform a search.

2. Click the Search icon.

3. In the Search Result pane, double-click on the individual record that you 
would like transferred to the Dataset Treeview pane (B).

TIP: When you enter information into any of the search parameters, clicking 
Enter will start the search and force search results to automatically 
transfer to the Treeview.

Note: When an individual file is transferred to the treeview, any previous 
dataset will be overwritten and replaced with the single file that was 
selected.
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Load to Treeview and Add (Append)

NEW! As data is loaded or appended to the Treeview from the Search, or the 
Saved Datasets form, the following rules apply:

When a record is selected for append, only new files will be loaded. If 
previously loaded, the file will not be reloaded into the Treeview.

If no search result is selected, the Add to Search Results button will be 
disabled.

Sorting Search Results by Column Heading

Search results can be sorted based upon column headings, and in ascending 
and descending order.

To sort search results based on the column headings...

1. Display the Predefined Searches pane.

2. Perform a search; the results will be presented in the Search Results 
pane.

3. Note the column that you would like to sort your results on; click on the 
column heading (A) to sort in ascending or descending order.

The direction of the arrowhead in the column head will indicate the direction of 
the sort. When the arrowhead is pointing upward, the sort is ascending, when 
the arrowhead is pointing downwards, the sort is descending. A click on the 
column heading will switch between ascending and descending. 
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The result will be sorted based on the column heading that you are using. 
When there are empty grids, i.e. NULL characters, those records are 
presented first when the sort is ascending, last if they are descending.

Govern Saved Datasets Pane

NEW!   As indicated earlier, the search process is one of the key functions in 
Govern. The function allows for the retrieval of a record or a collection of 
records or datasets from the database. Further actions such as creating 
permits, attaching messages, generating licenses, generating mailing lists, 
and so on, can then be performed on the records in these datasets.

The Govern Saved Dataset pane is new in version 6.0. This pane will allow 
users to load, save, and delete saved datasets. This pane lists all saved 
datasets for the current user (…excluding datasets that were present prior to 
the hibernate process). With this control the user is able to, create new 
datasets from a search result, append to an existing dataset, load, edit, or 
delete one or more datasets.

Saving Search Results

The result of searches, i.e. datasets, can be saved away and retrieved for 
further review at a later period. For example, a search can be made for all 
issued permits in a municipality, at a later period the same dataset can be 
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recalled without having to perform the same search. In addition, new search 
datasets can be added to the existing one.

To save a dataset...

1. Perform a search using the Predefined Searches pane.

2. If not selected, click to select the View tab in the ribbon.

3. In the Data Sources group, enter a name for the search.

4. When a name is entered, the option icons will be selectable.

5. Click Save Dataset.

The dataset will be saved under the name that was entered. Additional names 
will appear in the drop down list.

Appending to a dataset

New datasets from subsequent queries may be added or “appended” to an 
existing query. This is done with the Append option.

To append to an existing saved dataset...

1. Recall an existing dataset.

2. Perform a new search, and obtain the resulting records.

3. In the drop down menu of the Saved Dataset field, select the dataset that 
you would like to append to.

4. Click to select the Append option; click Save Dataset.

The newly added results will be appended to the existing one. Additional 
datasets can be appended to an already existing saved dataset.

Note: Until a name is entered for a dataset, the option icons will be 
“ghosted”, i.e. not selectable.

Note: The dataset information is saved in the USR_SAVED_DATASETS 
table. 
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Business Tax Search

In the Business Tax (SRT) Data Entry form, you can perform a search by SRT 
Account Number, SRT Filing Info., or SRT Category for the individual or 
company. A series of specialized Predefined Searches are available for the 
Business Tax profile. The criteria for these searches can be accessed as a 
Group Search or a Style Search. Group Searches combine a series of search 
criteria, like an Entry Date, Reporting Period, and a Period No. A Style Search 
will deal with one specific criteria like a Name.

To access Business Tax search criteria...

1. In Govern, click on the Govern suite button and select Open > Business 
Tax..

2. Click the Forms Explorer tab to display the OpenForms that are in the 
Business Tax profile.

Overview
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3. When the Forms Explorer is displayed, double click on the Business Tax 
OpenForm. 

Now, it will be necessary to set the Pre Defined Searches for Business Tax.

4. In the interface, click to select the View tab.

5. In the Data Sources group in the ribbon, select Predefined Searches.

6. In the form, choose an option under the Self Reported Tax Search 
column.

7. Click Search.
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The results will be displayed in the search results pane of the search form.

Business Tax (ST) Search Parameters

A search can be performed based on any of the criteria listed under the Self 
Reported Tax Search pane. Search options can include the following:

• By SRT Account
• By SRT Filing Information
• by SRT Category
• By Phone Number (STX)
• By Address
• By Name

The search criteria displayed are dependent upon system configuration and 
user access

Common Parameters

SRT Account No.: Enter the required SRT Account number for the record.

Category: Search based upon the SRT Category, these are the SRT 
categories in (Table: VT_USR_ST_CATEG).

Include Inactive: When searching you may want to include accounts that 
have been set to inactive; click the Include Inactive option to include these 
accounts. By default inactive accounts are not included in search results.

By SRT Filing Information

Entry Date: Enter the entry date that the report was made in the parameter. 
Use the MM/DD/YYYY format. Alternatively, you can click the drop down 
menu to display a calendar.

Reporting Period: Select a Reporting Period from the drop-down menu. 
Suggested Reporting periods might be quarterly or monthly.

Period #: Enter the period number that the accounts are entered in; 1 for 
monthly, 2 for quarterly.
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Self Reported Business Tax Quick Search

The search feature can be enhanced with a “Quick Save and Search” option 
that improves data entry.When configured this feature reduces the time 
between saving a modification on a record and having to reopen the Search 
form to search for another record. This feature is designed for users that need 
to make multiple successive entries. The Quick Search feature can be 
configured by users with administrator level access.

Configuring the Quick Search

Administrators that need to configure the Quick Search feature should refer to 
Configuring Quick Search on page 107 for details.

Using the Quick Search

The ST Quick Search is designed to facilitate rapid entry of information. This is 
achieved by avoiding the step of the user having to open the Search screen 
after a modification has been made to a record.

To the end user, the Quick Search is a toggle icon that is quickly identified 
when enabled.The dark background is used to provide contrast between other 
icons on the tab

State Appearance of Icon

Off

On
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When enabled with a click, the user will make an entry or update a record; and 
click Save. The Quick Search is immediately launched, and the cursor is 
active in the search field, prepared for the user to enter the next filing account 
to be retrieved.
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Self Reported Tax Account 
Maintenance

The Account tab of the Self Reported Tax OpenForm is used to maintain the 
information of individual and/or company accounts that you would like to 
collect levies from.

To access the Self Reported Tax Account Maintenance parameters:

1. Perform a search, as described in Business Tax Search on page 58, for 
the individual or company for whom you want to create an account.

2. To access this form, select a record and if not already selected, click the 
Account tab.

Under the tab you can review the Name and Address of the selected indi-
vidual or company, this is to ensure that you are looking at the correct 
account and information.

Overview
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Account Maintenance
Creating a Business Tax Account

To create a new Business Tax Account...

1. Under the Business Tax Account tab, click New.

2. Select a Category, and a Default Period.

3. Click Save . The account number is automatically generated and 
entered in the Account Number field.

4. Click Save.

Setting the Account Number Increment

If a value has been entered in the Increment parameter in the Business Tax 
General Parameter form in the Govern New Administration (GNA), the newly 

Note: This system generated account number can be manually over-ridden; 
see  Override Generated Account Numbers on page 65 for details.

Note: The Name & Address field is automatically populated with the name 
and address information from the selected record.
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generated account number increment will be by this value. See Control 
Account Number and Increment on page 32.

Override Generated Account Numbers

When required, it is possible to manually override the system generated 
Account Number in the Business Tax - Account Maintenance form.

To override a system generated Account Number...

1. In Govern, select an existing account number in the Account Number 
parameter, or at the point when a new Business Tax Account is being cre-
ated.

2. Click inside the field to highlight and modify the Account Number.

Specify your Reporting Period

As there is no standard default reporting period, this value can be set under 
the Period tab of the Business Tax - Periods form.

To specify a Reporting Period when creating a new account...

1. In Govern, select the Business Tax profile.

2. Open a record; if not selected, click the Account tab.

3. Under the Account tab, click New.

TIP: When a change is made to an account number, it is a good idea to insert 
a Global Message as a means of notifying others of the change. Refer 
to the Govern Release 6.0 user guide for details about Global 
Messages.
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Account Maintenance
4. A Period Status screen is displayed, select the Category, Period Code, 
and Start Date. The period must be defined in the Business Tax Period 
form in GNA.

5. Once all parameter have been selected, click OK.

Period Status form command buttons

Category: These are the categories of Business Tax that have been defined 
in the business Tax Categories form.

Period Code: This indicates the frequency that the account will file. For 
example, if reports are due once a month the period is Monthly.

Start Date: Specify the Start Date for the account filing.

Reason Code: This is an optional parameter; it allows the user to provide a 
reason why the period of the ST account was changed.

OK / Cancel: Click OK to accept the changes, or Cancel to cancel the 
creation of the account, or changes 

Business Tax Account Creation Rules

The following rules apply to the creation of a Business Tax account.

• Once the Business Tax Account has been created, the Category cannot 
be changed. 

• The user must specify a Period Code and Start Date; if they are not 
provided, the OK button will be disabled. Once the Period Code and Start 
Date are selected, the OK button is enabled for confirmation.
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• The Cancel button will close the window and return to the user to 
theAccount without changing the period of the current ST Account.

• The Reason Code is optional. This parameter allows the user to provide a 
reason why the period of the ST account was changed.

• When the OK button is clicked, the current entity data is considered as 
“dirty”, and a red dot will be displayed.

In the account creation process, if additional information pertinent to the 
account is required to be entered, it can be made in the Notes field

To include additional notes, if not on the Accounts tab, click the Accounts tab.

Additional Notes

In the account creation process, if additional information pertinent to the 
account is required to be entered, it can be done in the Notes field

To include additional notes, if not on the Accounts tab, click the Accounts tab.

1. Under the Account tab, locate the Notes field.

2. If the account is inactive, select the Inactive option and enter a range of 
dates in the Status Information.

3. Click Save  on the tab.
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Self Reported Tax Filing

Under the Business Tax Filing tab, use the Filing Information sub tab to enter 
collection information, to view totals, interest payments, and levies for each 
Business Tax record. The Filing Information tab may be referred to as the 
Business Tax Data Entry form.

To access the Business Tax Data Entry form and make entries...

1. Select an active SRT account, or create a new one with a click on New 
under the Account tab.

2. Click the Filing tab; click New to create a new entry.

In the form, the parameters become active allowing you to enter tax details.

Overview

Note: Administrators with the eGovern solution installed have the option to 
offer online filing of SRT reports to their users. These administrators 
will need to create an online version of any existing SRT forms that will 
for offered for online filing. Refer to the Business Tax Editor section of 
the MS Govern - eGovern Public Self Service Portal Release 6.0 user 
guide for details.
© 2015 Harris Govern Page 68



Self-Reported Tax
Create a New Business Tax Account 

To create a new Business Tax record...

1. In the Period Status form, select a Category, Period Code, and Start 
Date.

2. .

3. Select a Reporting Period. See Self-Reported Tax Periods on page 36.

4. Select a Period #. This refers to the Due Date, The First Due Date for the 
period is Period #1; the second is Period #2 and so on.

5. The Due Date and Next Due Date are automatically displayed based on 
the parameters set on the Business Tax Periods form in the Govern New 
Administration.

6. The fields, from the Business Tax Fields form for the selected category are 
automatically displayed and calculated according to the computation rules, 
defined in Govern Admin.

7. Click Save to save the entered data (Table: ST_FILING_FIELDS).

Modifying Business Tax Entries

When regular reporting entries are made, errors in the reporting can be made. 
For example you may have entered that you collected $1200 in sales tax for a 
reporting period, and posted the entry to the A/R. At a later period, it is 
discovered that the amount was only $1100. It is possible to return to the 
posting period and make an correction.
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Duplicate Entries for Same Period are Flagged

Business tax duplicate entries are flagged as duplicates. When flagged, 
duplicate entries can display a red label, “Amended Period” or “Audited 
Period”. In addition there is also a label that displays Corrected Period for 
records that were already posted and then later corrected. (Table: 
ST_FILING_MASTER). 

To make a modification/correction to a reporting period...

1. Open the posted filing and select the Tax Filing tab.

2. Under the Filing Information sub tab.

3. Click New to make your entry, change the Period # or Due Date; the 
Duplicate Period query appears; 

4. Select one of the options of Create Amended Filing, or Create 
Corrected Filing, or Audited Period.

5. Make your amendment, save, and re-post the record to the A/R.

Corrected Period

Select the option for Corrected Period to correct an already posted entry; in 
this instance, an Adjustment Record is created and the entry is re-posted. The 
system will indicate that this is a corrected entry for this period by displaying 
Corrected Period in red.
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Amended Period / Audited Period

Amended Period is to be selected when making amendments to a record but 
in this instance the original posting still remains, and a new  “amended” entry 
is made and posted; the same methodology is used when selecting the 
Audited Period option, except it is used in instances of an Audit.

 During the posting, the differences between the last filing and the new one will 
be posted in (Table: ST_FILING_MASTER).

A note about Amended Files

NEW! When amending a record, users should note that the system does not 
support a true amended filing, instead it will present an interface to the user to 
perform a corrected filing. This solution allows users to quickly enter data 
while reducing the risk of A/R computation bugs.

In order to amend a filing, users will need to navigate to find the account/filing 
record to be processed. If the record is already posted, they will have the 
ability to click on the Amend current filing button.

Amending a filing is exactly the same as correcting a filing with the following 
notes:

• Data in the filing screen will be cleared out
• The amended return Effective Date is the current date (editable)
• During the save process, after creating the history ST_ID, the system will:
• For numeric fields: You will need to add the new value to the old value.

• For Example: If field1 was 300, and the user enters -100, the value 
after a save will be 200. 

• If no value was entered, the Govern system will keep the previous 
value. 

• For all other fields, the system will replace the value. 
• If no value was entered, the Govern system will keep the previous 

value
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In the database, there will be no trace of an amended return. After the save, 
the user will see an un-posted corrected return in the form, this return will be 
the sum of the previous filing and the data that was just entered. 

Option for “Zero Filer” on Data Entry Form

Business Tax filings are made according to your Reporting Period settings. 
Occasionally, there will be periods where you will have nothing to report; i.e. 
no sales, collected duties or deductions. In such instances, a “zero filer option” 
is available in the form. This option, when selected and saved, will ensure that 
all parameters are set to zero.

To report a period with no entries in Govern...

1. Select an Account.(A)

2. The current date is automatically displayed in the Entry Date field (2). You 
can modify this if required.

3. Select a Reporting Period (3) from the drop down menu. See Self 
Reported Tax Periods on page 44 for details about periods. This refers to 
the Due Date, The First Due Date for the period is Period #1; the second is 
Period #2 and so on.

Note: Users should note that for Govern, amending a filing is the same as 
correcting a filing; the approach is an alternate way to do it.
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4. The Due Date and Next Due Date (4) are automatically displayed based 
on the parameters set on the Business Tax Periods form in the Govern 
New Administration (GNA).

5. Click to select the Zero Filer option (A).

6. Click Save to save the entered data (Table: ST_FILING_FIELDS). 

Zero Filer Quick Entry

NEW! As an alternate method to manually entering an individual record, there 
is the Zero Filer Quick Entry feature. This feature updates un-filed ST records 
to the zero filer using the current Fiscal Year, Department, and User Login in 
the application. A grid is displayed that is populated with all un-posted ST 
records that are classified as un-filed (Table: ST_FILING_MASTER.UNFILED 
= -1) ; the updated filing that is added to the grid will need to provide a 
barcode. Details of the barcode are as follows:

Details of Zero Filer Barcode

The barcode that is to be supplied is defined in 3 parts using the separator “-” 
as a separator. The required data for generating the barcode can be retrieved 
from the database from (Table: ST_MASTER, and ST_FILING_MASTER) 

Generated barcodes must take the following format:

Note: If you are a user of the Web site, this option equates to a submission 
where there is nothing to report.
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*accountNo-periodNo-yearID*

• Part 1 - Reserved for the Account Number. (Table: 
ST_MASTER.ACCOUNT_NO)

• Part 2 - Contains the period number. (Table: 
ST_FILING_MASTER.PERIOD_NB)

• Part 3 - Must display the year. (Table: ST_MASTER.YEAR_ID)

Basic Sample Query to Generate Barcode String

-- Bar Code Query - UNFILED = -1 / 0 for Filed --

SELECT CONCAT('*',STM.ACCOUNT_NO,'-',STFM.PERIOD_NB,'-', 
STFM.YEAR_ID,'*') AS 'Bar Codes'

FROM ST_MASTER STM JOIN ST_FILING_MASTER STFM

ON STM.ST_ACCT_ID = STFM.ST_ACCT_ID

-- Specify Account No. Range for Un-filed Accounts --

WHERE STM.ACCOUNT_NO >= '00045101' AND STM.ACCOUNT_NO <= '00045151' 
AND STFM.UNFILED = -1 AND STFM.YEAR_ID ='2015'

ORDER BY STM.ACCOUNT_NO ASC;

-- STOP --

Sample Result
*00010010-1-2010*

*00010010-2-2010*

*00010010-3-2010*

*00010010-4-2010*

The result of the query should be imported into a spreadsheet application or 
word processor and formatted with the barcode font that is recommended for 

Note: The asterisk characters that begin and terminate the string are 
required.

Note: The query results can be modified to include the account name beside 
the barcode string.
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the reader. Once formatted and printed, the barcodes can be scanned with 
reader to rapidly enter the information.

Posting an Entry

After a report has been filed, the entry can be immediately psoted to the 
Accounts Receivable for processing. 

To post a report...

1. Under the Filing tab complete a report.

2. Click Save to save the report.

3. Under the Filing tab click Post to A/R.

4. At the prompt, click Yes, to accept.

Result Encoded with Barcode Font

*00010010-1-2010*

*00010010-2-2010*

*00010010-3-2010*

*00010010-4-2010*

*00010010-1-2010*

*00010010-2-2010*

*00010010-3-2010*

*00010010-4-2010*
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The report has now been posted to the A/R. In a municipality office situation, 
citizens may be present and wish to settle the payment. This can be achieved 
though the A/R Payment Data Entry form.  

To make a payment through the A/R Payment Data Entry form...

1. Under the Filing tab of the report that was posted, click Post to A/R.

2. In the A/R Payment Data Entry form, select a Transaction Type, Deposit 
Information, and any notes that should be included with the payment.

3. In the Details group, specify any additional details, e.g. payment is only 
effective as of a specific date.

4. Also specify the amount of payment, the method, and any reference 
information.

5. In the Payor Information group, specify the name of the payor. Click C, to 
open the Search by Name form; click R to remove a name.

6. Click Save.
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A/R Posting Link is based on ST_ACCOUNT_ID

When a Business Tax posting, an amendment, or a duplicate filing, is made, it 
is linked to (Table: AR_MASTER) by the ST_ACCOUNT_ID. 

Total Values tab

The Total Values tab is a sub tab of the Filing tab. This tab displays the 
following information:

Tax Information / Amount group

Taxable Amount: This field displays the total calculated from the Filing 
Information tab.

Net Tax Amount: This field displays the Net Tax Amount. You can override 
this field, provided you have access rights to the function.
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Special Charges / Penalty group

This section displays penalty and interest information, as required. Select the 
charges that apply. The amounts are calculated from the values entered for 
the selected tax category in Govern Admin. See Self-Reported Tax Categories 
on page 16.

• Incorrect Filling Penalty
• Incorrect Payment Penalty
• Negligence Penalty
• Returned Check Penalty
• Other Adjustments

A/R Information group

The A/R information that is related to the period entries is displayed in the A/R 
Information group.

Levies and Exemptions tabs

The Levis / Exemptions tab displays the amounts allocated for each A/R 
Class, with a Total Balance. Select the Levies / Exemptions tab to display the 
levies on the selected record.

The following information is displayed on the levies, with a total amount:
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• Levy Code - This is the name specified for the levy
• Base Value - The base value is the amount from a standard table used for 

the calculation of the type of Levy 
• Base Exempt Value - Under this column is the amount of the exemption
• Net Base Value - This is the result of the base value minus the exemption
• Rate Value - Displayed under this column is the levy rate
• Tax Amount - The tax amount is the resullt of the net value and the rate
• Exempt on Net - Exemptions can be made before or after a computation. 

If the exemption is on the Net Value for the line item, the amount would 
appear under this column, otherwise this cell is blank. 

• Override - If you want to perform a manual override of the Net Tax 
Amount, select a yes fromthe drop-down menu

• Net Tax Amount - This is the resultant of the calculation. If the Override is 
set to Yes, this amount can be manually changed.

Select Post to A/R on the Filing tab to transfer the payment information to 
the Accounts Receivable subsystem. You can view the Business tax 

information in the Accounts Receivable Inquiry function. Refer to the Accounts 
Receivable guide for details.

Select Payment on the Filing tab to open the Accounts Receivable 
Payment Data Entry function and accept payment for the Business tax 

record. Refer to the Accounts Receivable guide for details.

Manual Override for Discounts and Penalties

In the Business Tax - Data Entry form, if a maximum discount or penalty 
amount is exceeded when making an entry, you can manually override it. Note 
that in instances of a late filing, the override cannot be used.

Note: After a posting you will not be able to perform the manual override.

Note: A manual override can be made as long as the records have not been 
posted to the A/R.
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To make a manual override In Govern.....
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1. In a department with access to Business tax Information, open a record.

2. Select the Filing tab in the Business Tax OpenForm.

3. Click New, on the tab in the form to make a new entry.

4. Make your entry under the Filing Information tab.

5. Click Save.

6. Select the Levies tab.
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Linking in Self Reported Tax
If required, information can be linked to a Business Tax filing through the Links 
tab. Use the Links tab to connect the following information to the record:

• Other Parcels
• Other Departments
• Permits, Offenses, or Workflows
• Buildings
• Inspections
• Misc. Billing
• Utility Billing
• Personal Property  

Linked Permits / Offenses / Complaints

Linking a Permit, Offense or Complaint to a SRT Record

Click New on the Linked Permits / Offenses / Complaints tab to open the Add 
screen that displays all Permits, Offenses, Complaints for the current record. If 
options are available select all applicable items and click Load. When the 
record has been added to the list, click Save.

Linked Buildings

Linking Other Buildings to the Record: To link other buildings to the list, 
click New and select all the applicable buildings from the Browsing screen.

Removing a Building Link from the Record: To delete a link to a 
building, highlight the building in the To Buildings text box and click Delete.

Linked Inspections

Linking an Inspection to a Record: Click New on the button on the 
Inspections tab to open the Add screen. This displays all Inspections 
associated with the current property. Double-click to select the Inspection you 
want to link, and click Load to the search result.

Removing an Inspection Link from a Record: Highlight the inspection 
link you want to delete and click Delete.
© 2015 Harris Govern Page 82



Self-Reported Tax
Linked Misc. Billing (MB) Accounts

Linking a Misc. Billing Account to a Record: To add an account to a 
record, click New. This opens the Add Link search screen with the required 
parameters to select. Click Search to display results with accounts that can be 
associated with the record. Double-click to select the account to link, click 
Load to the Search Result. When the account has been added to the list, click 
Save.

Removing a Misc. Billing Account Link from a Record: To remove 
an account from the record, click to highlight it; click Delete.

Linked Utility Billing (UB) Accounts

Linking a Utility Billing Account to a Record: To add an account to a 
record, click New. This opens the Add Link screen that displays all accounts 
associated with the record. Double-click to select the account to link, click 
Load to the Search Result. When the account has been added the list, click 
Save.

Removing a Utility Billing Account Link from a Record: To remove 
an account from the permit, click to highlight it; click Delete.

Linked Personal Property (PP) Accounts

Linking a Personal Property Account to a Record: To add an account 
to a record, click New. This opens the Add Link search screen with the 
required parameters to select. Click Search to display results with accounts 
that can be associated with the record. Double-click to select the account to 
link, click Load to the Search Result. When the account has been added to the 
list, click Save.

Removing a Personal Property Account Link from a Record: To 
remove an account from the record, click to highlight it; click Delete.
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Self Reported Tax Mailing Index

The Business Tax Mailing Index tab is used to maintain bill recipient 
information. Under this tab, you can view and modify information, such as the 
mailing address, mailing type, primary index status, payer information, Inactive 
account status information, and forward e-mail messages. The primary index 
is the name that will be linked to the invoice. Within the mailing Index, you can 
also add secondary names. For example, being the owner of a franchise 
organization, all invoices are sent to your head office - the primary name, but 
an additional invoice may be sent to the franchise location.

To access the Business Tax Mailing Index...

1. In Govern, click on the Govern suite button and select Open > Business 
Tax..

2. Click the Forms Explorer tab to display the OpenForms that are in the 
Business Tax profile.

3. When the Forms Explorer is displayed, double click on the Business Tax 
OpenForm. 

4. Click to select the Mailing Index tab.

The Mailing Index information is attached to the name and account of the 
currently selected record. This information can be seen by selecting the 
Account tab

Overview
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Business Tax Mailing Index - Command Buttons

 Creating a New Mailing Index Record: Click New to clear the form 
and create a new record.

 Saving a Mailing Index Record: Click Save to save a new record or 
any modifications made to an existing one.

 Deleting a Mailing Index Record: Click Delete to remove the current 
record. A confirmation message is displayed if there are any unsaved 
modifications. 

Click Yes to continue or No to return to the Business Tax Mailing Index 
function. A message is displayed in green in the bottom right corner of the 
screen to indicate the record is deleted.

Name: Click Name to launch the Name & Address Maintenance function. You 
can view additional information on this screen or make any required 
modifications. Refer to the Property Control guide for more information on the 
Name & Address Maintenance function.

 Browsing Mailing Indexes: Click Browse to view a list of the names 
and addresses of the recipients of the bills.

 Set as Primary Index: Click Set as Primary Index to assign the 
current record as the primary index. When selected, the Primary Index check 
box under the General Info. tab will be selected. See Primary Index on 
page 86 below for associated conditions.
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Mailing Index General Info. tab - Parameters

Name & Address: This field displays the name and address information for 
the selected Business Tax account. To modify this information, click Name, as 
described above. To use an alternate name and address record or to create a 
new one, click C to open the Name Search screen. Click Search to select an 
existing record or click New to create a new one. Refer to the Business Tax 
guide for more information on the Name Search.

Mail Type: Select the Mailing Type, from the drop-down list; such as, 
Managing Agent, Mortgage, Owner or Payer, Previous Customer, Temporary 
Owner or Third Party Mortgage (Table: VT_SY_MAILTYPE).

Primary Index: When selected, this option indicate the person or company 
displayed in the Name & Address text field is the Primary Index.

The following conditions apply to the Primary Index.

• You can have only one primary index per account.
• If a primary index is not selected, by default, the first name and address 

record entered becomes the primary index.
• The original bill is sent to the primary index only. All other persons and 

companies in the mailing index receive a duplicate bill, unless the Do Not 
Send Bill option is selected.

• If the name status for the record selected as the primary index is set to 
inactive, a duplicate bill is sent to this record and the Temporary Owner 
receives the original bill.

• The primary index indicates the name displayed on all reports.

For example, if the Business Tax bill is to be paid by the tenant; select this 
record as the Primary Index. The owner is sent a duplicate bill.

Duplicate Bill: Select this option to create a duplicate bill.

No Paper Bill: The No Paper Bill option, when selected, will stop the printing 
of a paper bill that is sent by conventional mail.

Sequence Priority: Enter a priority sequence to define the order in which 
bills are sent out. A priority number of 1 is sent out first, as the number 
increases, the lower the priority. 

To set up the Priority Sequence, enter one of the following:
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• Enter 1 in the Priority Sequence parameter of the mailing index records for 
the individuals and companies whom you want to receive first billing.

• Enter 2 for those whom you want to receive second billing and so on.
• Leave this field blank for those whom you want to receive billing in the 

standard order, after the priority records are sent out.

Notes: This field provides unlimited space for notes and comments.

Status Information group

Inactive: Select this option to set this account as inactive. When selected, a 
range should be specified 

From Date / Until Date: Enter a range in these parameters to specify the 
date range that the account is to remain inactive.

• If the Inactive option is selected and dates are entered in the From / To 
parameters, there will not be any bills sent during this period.

• If the Inactive option is not selected and dates are entered in the From / 
To parameters then the bills will be sent during this period.

Bill by Email: The send Bill by E-mail option, when selected, will allow the 
system to send Bills to the e-mail address that is specified in the E-mail 
Address field. If the Do Not Send Bill option is selected, both the option and 
the field will be disabled.

Email Address: Specify an email address that will be used when the Bill by 
Email option is selected.

Other Addresses: This parameter will contain the list, if available of 
alternative addresses that the mail can be forwarded to.

Account History

NEW! The approach was changed as it was complicated to see when the 
account was active and inactive. It was replaced by the last status date for 
start of inactive or start of active.
Page 87 © 2015 Harris Govern



Self Reported Tax Mailing
Index
ACH Info. group

The Automated Clearing House (ACH) feature is used for electronically 
transferring funds from the customer’s financial institution for bill payment.

Customer account information is entered in the ACH Information by Name 
function. Refer to the ACH Processing chapter in the Accounts / Receivable 
guide for details.

From Date / Until Date: Click the drop down menu beside the date fields 
and select a range of dates from the pop-up calendar if the ACH is to be used 
during a specific time only. You can also enter a date in the From field or the 
Until field only.

Include in ACH: Select this option if the ACH is to be used during a specific 
time only.

Forwarding Mail

Forwarding mail overrides and redirects or “forwards” correspondences or 
billing information for a user specified length of time. 

To override a billing address:

1. Link to an existing Name ID with the search or create a new one.   

2. In the Status Information group, click in the date parameters and select the 
From Date and Until Date dates for the period during which you are 
forwarding the bill.

3. If a copy is to be sent by Email message, click activate and enter the Email 
address, 

Note: The ACH Info. fields are enabled for the Primary Index only.

Note: The fields under this tab are enabled only if the Support Billing 
Address Forwarding option is selected on the System Registry 
Maintenance form in Govern Admin.
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Self Reported Tax Occasional Filing
The Self Reported Tax Occasional Filing account has the same functionality 
as the standard Self Reported Tax Filing with the exception that the record is 
created without a specified Period. This feature is designed for the occasional 
or “seasonal” business. This feature facilitates the process for filers as they 
will not have to submit Zero Files for outstanding months when they are not 
operating, this was the previously accepted workaround. All accounts with an 
occasional flag will have their Period Code and Period Number hard coded 
with a default value set to -1.

As an added feature businesses that initially begin using the occasional filing 
model may at a later date be converted to a standard period based filing 
model without any system impact. See  Converting from Occasional to 
Standard filing on page 91.

The Business Tax Occasional Filing form ideally can be used for the 
occasional or “seasonal” business. See Self Reported Tax Filing on page 68.

The Process

The ST Occasional Filing form has a button called Search & Create 
Occasional Filing. This button allows users to search for an existing ST 
account, or create a new name and account in the system. Once the existing 
account is found or a new account is created, users can enter a new filing in 
the system by providing necessary information like the Entry and Due Date.

Search and Create 
Occasional Filing

To create anew Occasional Filing...

1. Click Search & Create Occa-
sional Filing on the filing infor-
mation tab item.

2. A popup window is displayed to 
allow you to search the Name / 
ST Account that you wish to 
create in the Occasional Filing 
form.
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Occasional Filing
3. Provide a vendor name or telephone 
number. The result displays a list of all 
available vendors with a radio button 
beside each.

4. Choose the required vendor. If the vendor 
does not exist, you have the option to 
create a new vendor.

The system will create the vendor in the following tables:

• NA_NAMES
• NA_COMPANY_INFO
• ST_MASTER
• NA_MAILING_INDEX

The default period in ST_MASTER is set as OCC_VENDOR. All created Filing 
Period numbers will be set to -1.

5. After you have searched and/or 
created a new account, select a 
category and click on Create Filing.

Self Reported Tax Filing tab

The filing information that is required to be entered is identical to that of the 
standard form.

Self Reported Tax Filing tab: Refer to Self Reported Tax Filing on 
page 68 for details.
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Self Reported Tax Account tab:  Self Reported Tax Account 
Maintenance on page 63 for details.

Converting from Occasional to Standard filing

To convert an Occasional Filing account to a standard “period” based account.

1. Under the Self Reported Tax Occasional tab, select the Self Reported Tax 
Account tab.

2. Locate the Period group; for the Occasional account, the period will 
indicate N/A. 

3. Click the Ellipses to display the Period Status form.

4. Specify a Period Code that the account will now follow, i.e. Monthly, 
Quarterly, Annually, and so on.

5. If used, select a Reason Code to justify the change in account type. Click 
Save.

Once saved with a period, the account periods that correspond with the 
frequency, i.e. Monthly, Quarterly, and so on, will now be generated by the 
system.
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Business Tax Batch Processes

Batch Processes that are related to the Business Tax module are located 
under the Views (tab) > Batch Process (View group) on the Govern ribbon.

General Layout of the Batch Processes form

When sufficient security access is given, a click on the Batch Process (A) tab 
displays the Batch Process menu (1); click the menu to display available     
processes in the Govern ribbon (2)...

1. Click the Batch Process tab.

2. Select the Business Tax Process.

3. Click to select the required menu or submenu.

Overview

Note: Access to the Batch Process tab and specific batch processes is a 
function of the level of security that is granted to the user.
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Business Tax Batch Process Parameters 

Under the Parameters tab are the fields that are used to configure and launch 
the Batch process. 

Selection Criteria group

In the Selection Criteria group, select your criteria and applicable options. If no 
options are selected, the system recalculates all levy taxes.

Year: Enter the year to process.

Department: Enter the department to process

Category: Select the appropriate category.

From Entry Date / To Entry Date: Enter a date or a range of dates to 
process.

Note: The process requires that the Year and Department parameters are 
selected.in order to proceed.
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From ST Account No. / To ST Account No. Enter an account or a range 
of accounts to process.

Business Tax Parameters tab - Command Buttons

Execute: Click Execute to initiate the batch process.

Cancel: Click Cancel to abort the process and close the form.

The completed process and, or any associated errors will be displayed in the 
ribbon under the Processing tab.

Click on the expand arrowhead on the right hand side to display the full list of 
errors in the content of the form (A).
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Business Tax Process - Schedule tab

The Schedule tab is used to define a batch process that will run once or at 
multiple scheduled times. A scheduled process may be set to run on a weekly 
interval, or if required, more than once a week, or less than once a week, e.g. 
bi-weekly. 

Schedule tab Parameters

Under the Schedule tab are the parameters that are required to configure the 
batch process.

Name: Specify a name for the scheduled process.

Description: Enter a description of the process for informational purposes. 
This is usually a full description of the process Name.
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Scheduled Process: This is an informational field displaying the name of 
the batch process that is being scheduled. This field cannot be modified.

Activated: Select the Activated option to enable the schedule.

Owner: The owner is a drop down menu that can specify the name of the 
owner of the process. By default, this field displays the log-in user name.

Settings group

The parameters available in the settings group will change based upon the 
Settings radio button that is selected; i.e. One time, Day, Week, or Month.

Settings - One time option selected

One Time: Select this option to schedule the process to run for one time 
only. 

Start Date: When the One Time option is selected, the Start Date parameter 
is the only one that will be displayed. In the parameter, enter a Date and Time 
for the process, or click the calendar button to manually select from the 
calendar.
© 2015 Harris Govern Page 96



Self-Reported Tax
Settings - Day option selected

Day: This option is to be selected for batch processes that are to occur every 
fixed number of days, independent of a day of the week or a date in the 
month. For example this could be used for a process that is to be run every 
two (2) or three (3) days. When the Day option is selected, the following 
parameters are available:

Start Date: When the One Time option is selected, the Start Date parameter 
will be displayed. In the parameter, enter a Date and Time for the process to 
begin, or click the calendar button to manually select from the calendar.

Expires on: When the process has a finite date, i.e. a termination date, 
select this option and specify the date and time. By default this option is not 
selected, an indication that the process will be repeated indefinitely until 
manually stopped.

Recur every <DAY> day(s): <DAY> represents the interval in days that the 
process is to be repeated.

Repeat every: <MIN> minutes: Select this option to specify a process that 
is to be run every <MIN> minutes. <MIN> represents the interval in minutes 
that the process is to be repeated every number of days specified.
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Settings - Week option selected

Week: This option is to be selected for batch processes that are to occur 
every fixed number of weeks, independent of a date in the month. For 
example this could be used for a process that is to be run every two (2) or 
three (3) weeks. When the Week option is selected, the following parameters 
are available:

Start Date: When the Week option is selected, the Start Date parameter will 
be displayed. In the parameter, enter a Date and Time for the process to 
begin, or click the calendar button to manually select from the calendar.

Expires on: When the process has a finite date, i.e. a termination date, 
select this option and specify the date and time. By default this option is not 
selected, an indication that the process will be repeated indefinitely until 
manually stopped.

Recur every <WEEK> week(s): <WEEK> represents the interval in weeks 
that the process is to be repeated.

On <DAY_OF_WK>: After selecting the Week option, in the On: parameter, 
you will need to select the <DAY_OF_WK>, i.e. day, or days of the week that 
the process is to be run. Select one or more of the days of the calendar week.

Repeat every: <MIN> minutes: Select this option to specify a process that 
is to be run every <MIN> minutes. <MIN> represents the interval in minutes 
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that the process is to be repeated every day or number of days of the specified 
calendar week.

Settings - Month option selected

Month: Select the Month option for batch processes that are to occur every 
fixed number of months, independent of a day of the week in the month. For 
example this could be used for a process that is to be run every first 1st and or 
15th of the month. When the Month option is selected, the following 
parameters are available:

Start Date: When the Month option is selected, the Start Date parameter will 
be displayed. In the parameter, enter a Date and Time for the process to 
begin, or click the calendar button to manually select from the calendar.

Expires on: When the process has a finite date, i.e. a termination date, 
select this option and specify the date and time. By default this option is not 
selected, this is an indication that the process will be repeated indefinitely until 
manually stopped.

Recur every <MONTH> month(s): <MONTH> represents the interval in 
months that the process is to be repeated. For example, if you specify that the 
process is to run every two (2) months on the 1st and the 15th, and the date 
that the process was set to begin is March 12; the process will then run once 
in March. The next month for the process to run would then be May 1st and 
May 15th, then July 1st and July 15th, etc. 
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On <DAY_OF_MTH>: After selecting the Month option, in the On: 
parameter, you will need to select the <DAY_OF_MTH>, i.e. day, or days of 
the month that the process is to be run. Select one or more of the days of the 
month.

Repeat every: <MIN> minutes: Select this option to specify a process that 
is to be run every <MIN> minutes. <MIN> represents the interval in minutes 
that the process is to be repeated every calendar day or days of the specified 
month.

Schedule tab Command Buttons

Save: Click Save to save the configured parameters.

Cancel: Click Cancel to abort the process and close the form.

The completed process and, or any associated errors will be displayed in the 
ribbon under the Batch Process tab.

Business Tax Process - Reports tab

The Reports tab is used to display any reports that are associated with the 
batch process. Reports may be automatically generated or require user input 
of required parameters. Refer to the Govern Scheduler release 6.0 guide for 
details about configuring reports for a Batch Process.

             Daily - Business Tax Computation

The Compute Levy and Exemption form is used to re-compute the levies and/ 
or the exemptions after a change in the tax rates, exemption amounts or 
percentages. It is recommended that this process be run prior to printing the 
tax bills.

To access this Batch process from Govern’s main screen

1. Click the Batch Process tab.
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2. In the Ribbon, locate Batch Process.

3. Click to select Batch Processes > Business Tax Process > Daily > 
Business Tax Computation.

Starting the Computation Process

Select your criteria and applicable options, then click Execute to launch the 
levy computation. If no options are selected, the system recalculates all levy 
taxes.

Year: Enter the year to process.

Department: Enter the department to process

Category: Select the appropriate category.

From Entry Date / To Entry Date: Enter a date or a range of dates to 
process.

From ST Account No. / To ST Account No. Enter an account or a range 
of accounts to process.

Business Tax Computation Command Buttons

Execute: Click Execute to initiate the batch process.

Cancel: Click Cancel to abort the process and close the form.

The completed process and, or any associated errors will be displayed in the 
ribbon under the Batch Process tab.

Daily - Business Tax Posting

Run the Business Tax Posting batch process to transfer the computed Real 
Estate tax values to the Govern Accounts Receivable module.

To access this Batch process from Govern’s main screen

Note: The process requires that the Year and Department parameters are 
selected.in order to proceed.
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1. Click the Batch Process tab.

2. In the Ribbon, locate Batch Process.

3. Click to select Batch Processes > Business Tax Process > Daily > 
Business Tax Posting.

Starting the Tax Posting Process

Select your criteria and applicable options, then click Execute to launch the 
Posting to process. If no options are selected, the system will post all records.

Year: Enter the year to process.

Department: Enter the department to process

Category: Select the appropriate category.

From Entry Date / To Entry Date: Enter a date or a range of dates to 
process.

From ST Account No. / To ST Account No. Enter an account or a range 
of accounts to process.

Periodically - Purge Processed Records from 
Input Tables

This Govern Batch process is run to purge processed records from the 
following tables:

• ST_IMP_PMT_INFO
• ST_IMP_RETURN_INFO

To access this Batch process function, from Govern’s main screen

1. Click the Batch Process tab.

2. Select the Business Tax Process.

3. Click to select Batch Processes > Business Tax Process > Periodically > 
Purge Processed Records from Input Tables
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4. A confirmation message appears; click Yes to proceed.

The progress of the process can be monitored in the status bar in the ribbon. 
Any messages or warnings will be displayed.

Periodically - Create Missing Filers 

The Business Tax - Create Missing Filer batch process is used to pro-actively 
generate the Business Tax (SRT) forms that will be filed for a given period. 
When following this process a form can be pre-generated for the period 
required for your process; monthly, quarterly, etc. Users will only be able to file 
the period that you have generated. This method offers the advantage of 
minimizing errors associated with users filing for the wrong period when they 
have multiple periods available to select from.

Business Tax – Create Missing Filer command buttons

Execute: Click Execute to initiate the batch process.

Cancel: Select to close the form without initiating the batch process.

Business Tax – Create Missing Filer Parameters

Selection Criteria group

Year: Enter the fiscal year that the SRT period that is to be generated will 
occur in.

Department: Select the relevant department from the drop down menu.

Category: Select the tax category from the drop down menu, e.g. Sales Tax, 
Business Expenses, etc.

Default Period: Depending on the period that has been defined for the filing, 
select a period from the menu; e.g. Monthly, or Quarterly.

Period Number: The period that is selected from the Default Period 
parameter will determine the options displayed in the period; select the period 
that is to be generated.
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Configuring the Batch Process

The Business Tax Create Missing Filer process is configured in the Govern for 
Windows GovAdmin application. An administrator will need to enter the path 
to the Deploy EZ Batch application shortcut parameter. Refer to the Govern 
Batch Processing Interface section of the Super User guide for details.

Running the Batch Process

To run the Batch Process in the Govern for Windows GovBatch application...

1. Select Business Tax > Special Procedures.

2. In the Special Procedures form, click to select the SRT - Create Missing 
Filer Special Procedure.

3. When the Business Tax – Create Missing Filer form is displayed, complete 
the parameters as needed.

After the batch process has been initiated, the batch process Status Bar is 
displayed with status information that is related to the process. Refer to the 
Batch Process tab section of the Govern Release 5.1 user guide for additional 
details about Batch Process errors.

If any errors are generated, click the status button to display any notifications 
that are associated with the process.

Note: If the error, ClickOnce Batch Shortcut has not been defined, is 
seen, you will need to configure the path to the Deploy EZ application 
under the Connections tab of the System Registry Maintenance form 
of the Govern for Windows GovAdmin application. Refer to the Govern 
Batch Processing Interface section of the Govern for Windows Super 
User guide for additional details.
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APPENDIX A:GENERAL CHANGES TO 
THE BUSINESS TAX MODULE

Changes between Business Tax and Self 
Reported Tax

Users of the Self-Reported Tax (SRT) module released prior to Release 6.0, 
i.e. Release 5.1 and Govern for Windows, will need to note the following 
changes between Self -Reported Tax (SRT) release 5.1 and Business Tax 
release 6.0.

Backwards Compatibility

Although there is some backwards compatibility in other systems, the 
Business Tax system does not offer this. This is as a result of changes made 
to certain tables such as the USR_USERFILE or VT_USER, does not offer 
this. there can be no roll back. This means that once users have transferred to 
the Release 6.0 Business Tax system, their Self-Reported Tax data cannot be 
rolled back. 

Note: As a result of the nature of the transfer of Self-Reported Tax data from 
pre 6.0 releases, user should note that there is no roll back option. As 
always users should diligently backup their prior to transferring to the 
new system. In the event of system error, 
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APPENDIX B:CHANGES TO DATABASE 
TABLES

As a result of the changes that are required for the new Govern Business Tax 
modules, the following changes have been made to the database:

Additions to Existing tables

The following columns have been added to (Table: ST_PARM_FIELDS)

• ALLOW_NULL
• NUMBER_MIN
• NUMBER_MAX
• DATE_MIN
• DATE_MAX
• SPELL_CHECK
• DISPLAY_TYPE
• TABLE_DISPLAY
• VALUE_OVERLAY

Changed Table Names

The name of the following (Table: VT_USER) is changed for the Field, Levy, 
and Exemption. These tables are created dynamically as in the following 
examples:

• ST_CategoryCode_FieldName ...where F refers to a Field
• ST_CategoryCode_LevyName ...where L refers to a Levy
• ST_CategoryCode_Exemption ...where E refers to a Exemption
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APPENDIX C:CONFIGURING QUICK 
SEARCH

The following steps describe the configuration of the ST – Quick Search 
feature. The Quick Search screen is displayed as a popup when Save is 
clicked on the ST Filing form. Note the steps that are required to enable the 
Quick Search feature.

Enable in User Registry

The first step in enabling the Quick Search is to set the SY_REGISTRY key 
value for Quick Search to TRUE.

To set the key to TRUE, open the User Registry

1. In Govern click the options button; select the Options icon.

2. On the User Registry form set the Registry Key Type to User ID.

3. Click under the Key Type column to enable the option to “Allow Quick 
Search”; click Save.
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Business Entity Designer

The Govern Business Entity Designer (BED) is used to create the entity for the 
form.

Govern New Administration (GNA)

In GNA use the Dynamic Search Style form to configure a search query.

1. Click Editors (tab) > Dynamic Search Styles In the GNA ribbon.

2. In the Dynamic Search Styles form, click New to create a New Quick 
Search (Search Name: stQuickSerach)
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3. Under the Key to Receive drop down menu, Select “NameID” .

4. Look for the query text box; paste the following query...:

SELECT 
ST_MASTER.NA_ID,ST_MASTER.ACCOUNT_NO,ST_MASTER.CATEGORY_C
ODE,NA_NAMES.NAME_INDEX, ST_MASTER.ST_ACCT_ID FROM 
ST_MASTER,NA_NAMES WHERE ST_MASTER.NA_ID=NA_NAMES.NA_ID 
AND UPPER(ST_MASTER.ACCOUNT_NO) LIKE 
@staccountnb_0[[ST_MASTER.ACCOUNT_NO]

Govern

In Govern the Quick Search can be initiated for quick entry when multiple 
successive entries are required.
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Business Entity Designer (BED)

Govern Security Manager
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